Copyright

Manual copyright 2018 Integrity Data. All rights reserved.

Limitation of Liability

The content of this manual is furnished for informational use only, is subject to change without notice and should not be construed as a commitment by Integrity Data. Integrity Data assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Integrity Data nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damage, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

Publication Date

January 2018
Contents

Installation Overview ................................................................................................................................................. 6
Prerequisite ............................................................................................................................................................ 6
Server/Client ...................................................................................................................................................... 7
Files Installed ................................................................................................................................................... 12
Manual Install ................................................................................................................................................... 12
Microsoft Outlook .................................................................................................................................................... 16
Multiple Outlook Profile................................................................................................................................. 16
Integrity E-Mail Addin Install .......................................................................................................................... 16
Install Notes ..................................................................................................................................................... 17
Mail Server Setup ..................................................................................................................................................... 20
Microsoft Exchange Setups for Employee E-mail Suite .................................................................................. 20
Set Up Adobe Writer for Employee E-Mail Suite ................................................................................................. 22
Registration .............................................................................................................................................................. 23
Activation Manager Window .............................................................................................................................. 23
Test and/or Historical Companies ..................................................................................................................... 24
Security Settings ...................................................................................................................................................... 25
Direct Deposit Setup ............................................................................................................................................... 27
Introduction to Employee Email Suite .................................................................................................................. 28
Internet Information Window ................................................................................................................................ 29
Assign an E-Mail Address to an Address ID ........................................................................................................ 29
Assign Multiple E-Mail Addresses to an Employee .......................................................................................... 30
E-Mail Suite Setup Window ..................................................................................................................................... 31
Missing E-Mail List Button ..................................................................................................................................... 34
Employee Exception List Button ......................................................................................................................... 34
E-Mail Earnings Statements Reports ..................................................................................................................... 36
Missing E-Mail List Report ..................................................................................................................................... 36
E-Mail Exceptions Report ..................................................................................................................................... 37
Password Setup ........................................................................................................................................................ 38
E-Mail Earnings Statements Process ..................................................................................................................... 39
PDF File Location ...................................................................................................................................................... 41
Create E-Mail Earnings History ........................................................................................................................... 42
E-Mail Statements Error Report ............................................................................................................................ 43
Introduction to E-Mail W-2 Statements ................................................................. 44
Timeline for Electronic W-2 Statement Delivery ...................................................... 45
Regulations Surrounding Electronic Delivery of W-2 Statements ......................... 45
E-Mail Suite Setup Window ....................................................................................... 47
  Missing E-Mail List Button .................................................................................. 50
  Manage W-2 Recipients ...................................................................................... 51
E-Mail W-2 Statement Reports ................................................................................ 52
  Missing E-Mail List Report .................................................................................. 52
  E-Mail W-2 Recipients Report .......................................................................... 53
E-Mail W-2 Statements Window ............................................................................. 54
E-Mail W-2 Statements Process ............................................................................ 56
PDF File Location ..................................................................................................... 57
  E-Mail Validation ............................................................................................... 57
E-Mail Statements Error Report .............................................................................. 59
Print W-2 Statements Window ................................................................................ 60
Sample Employee E-Mail and PDF Consent Form .................................................. 61
  Sample E-Mail ..................................................................................................... 61
  Sample PDF Consent Form ............................................................................... 62
Introduction to E-Mail 1095-C .............................................................................. 63
  Step 1: Login ....................................................................................................... 63
  Step 2: User Management .................................................................................. 64
  Step 3: Standard Measurement Period ............................................................... 65
  Step 4: Company Setup ..................................................................................... 67
  Step 5: Employee Data Import ......................................................................... 68
    Importing Employees ...................................................................................... 68
  Step 6: Import Employees .................................................................................. 70
  Step 7: View Payroll Employee ........................................................................ 71
Microsoft Dynamics GP Client Side Features ....................................................... 74
  Step 8: 1095-C Export ..................................................................................... 74
    Button Functions ............................................................................................. 75
  Step 9: Templates .............................................................................................. 77
  Step 10: Email Employees ................................................................................ 78
    General ........................................................................................................... 79
    1095-C and General Attachments .................................................................. 80
    Recipients List ............................................................................................... 82
Installation Overview

This section will discuss the prerequisites, list the files installed and go through the install process.

Prerequisite

The Employee E-mail Suite consists of two modules that provide additional capabilities for an existing Microsoft Dynamics GP installation: Employee Email Suite and E-Mail W-2 Statements.

The prerequisites for the Employee E-mail Suite:

- Microsoft Dynamics GP Payroll
- Direct Deposit
- .NET Framework 3.5 or above
- Adobe Acrobat Standard XI or DC
- E-Mail Sending Options
  - Microsoft Outlook 2013 or 2016
    Requires installing Integrity Email Addin and Visual Studio Tools for Office
  - SMTP Server – Outlook 365 and Outlook 2016 supported via SMTP setups

Install Notes

Prior to installing, validate the steps:

- Confirm all users are logged out of Microsoft Dynamics GP
- Complete all payroll runs and confirm no payroll runs are in process
- Make a backup of the company and Dynamics databases
**Server/Client**

To install Employee E-mail Suite downloaded the exe files from our [website](#). Once the files have been downloaded, you can run them on the Server and/or Client Installations. The product will need to be installed on all machines that process payroll. If you will send with using Microsoft Outlook then download the Outlook Setup.exe in addition to the Integrity GP 2018 Setup.exe

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® Components. Creating the Microsoft SQL Server Components needs to be performed on a single computer, typically the server.

1. Right click Integrity Data GP2018 Setup.exe file and select “Run as Administrator”. If you do not see this option, hold the shift key down and right click.

2. Complete the steps in the wizard
3. Verify the GP directory is correct if it is not select Change

4. Select Custom to choose to install only the specific products you purchased.
5. Select Activation Components to only install activation manager files. This option will not install products and it is typically run only to fix an error with activation manager.

6. Select All Components to install all Integrity Data products. The products you did not purchase will register with a 30-day trial period.

If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple products, it will uninstall all products.

7. Select the product(s) to install, if installing multiple products, select all that need to be installed.
**Integrity Data GP 2018 Setup - InstallShield Wizard**

**Custom Setup**
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

![Feature List]

- **Overtime Hours Rules**
- **Paycheck “What If” Calculator**
- **Enhanced Retirement Plans**
- **Life Insurance Tax Calculator**
- **Comprehensive Leave Manager**
- **Employee Email Suite**
- **HRM Solution Series Extensions**
- **Employee Accounts and S1**

Install to:
C:\Program Files (x86)\Microsoft Dynamics\GP2018\  

[Change...]

**Integrity Data GP 2018 Setup - InstallShield Wizard**

**Ready to Install the Program**
The wizard is ready to begin installation.

If you want to review or change any of your installation settings, click Back. Click Cancel to exit the wizard.

**Current Settings:**

- **Setup Type:** Custom
- **Destination Folder:**  
  C:\Program Files (x86)\Microsoft Dynamics\GP2018\%
- **User Information:**
  - **Name:** Windows User
  - **Company:**

[Install]

9. If prompted to include new code, choose yes.

10. Login as the ‘system administrator’ for each company to create the SQL Server components.

11. The system will auto activate the products you have purchased if you have access to the internet on the machine. If you receive a message Activation Manager failed contact support@integrity-data.com and include a screenshot of the Activation Manager window to receive manual keys.

**BEST PRACTICES**

Install is not a requirement on the **Server**; however it is recommended. Install updated version on previously installed **Client** machines.
Files Installed
GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)

- EES.cnk
- EES.chm
- Application.EmployeeEmailSuite.dll
- IDA6537.cnk
- Application.IntegrityDataActivation.dll
- Integrity.Registration.Constructor.dll
- iTextsharp.dll
- Integrity.Email.Addin.dll
- Microsoft.Office.Interop.Outlook.dll
- Integrity.Registration.Addin.dll

Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)

- Employee E-mail Suite User Guide.pdf

W2-Attach Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\W2-Attach)

- W-2 Instruction.pdf

Manual Install
If the user encounters errors during the installation, complete the following steps to manually install Employee E-mail Suite:

1. Contact support@integrity-data.com to receive the manual install files for the product(s).
2. Navigate to the Data folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data) and create the following folders.
   a. EES
   b. W2-Attach
3. Copy and paste the following files into the appropriate file locations.

   GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)

   - EES.cnk
   - EES.chm
   - Application.EmployeeEmailSuite.dll
   - IDA6537.cnk
   - Application.IntegrityDataActivation.dll
   - Integrity.Registration.Constructor.dll
   - ITextsharp.dll
   - Integrity.Email.Addin.dll
   - Microsoft.Office.Interop.Outlook.dll
   - Integrity.Registration.Addin.dll

   Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)

   - Employee E-mail Suite User Guide.pdf
1. Edit the Dynamics.exe.config
2. Send support@integrity-data.com your dynamics.exe.config file and reference needing help manually updating the Dynamics.exe.config file to manually install Employee E-Mail Suite and we will edit the file and send it back to you.
3. Launch Microsoft Dynamics GP.
4. Login as the ‘system administrator’ for each company to create the SQL Server components.
5. Add a registry key
   a. For 32 bit machines under HKEY_LOCAL_MACHINE > SOFTWARE create key IntegrityEmailSuite – see screenshot for 32 bit machine
   b. For 64 bit machines create IntegrityEmailSuite key under WOW64Node – see screenshot for 64 bit machine
   c. Under IntegrityEmailSuite create key GP2018

   ![Registry Editor Screenshot](https://via.placeholder.com/150)

   32bit Screenshot (please note the 32 bit screenshot doesn’t show correct paths for 2018. Only registry nodes)
c. Add new string value Path

d. Modify value - C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\EmailSuite
Microsoft Outlook

If Microsoft Outlook will be used to send the Employee Email Suite or the E-Mail W-2 Statements file to employees and track returned e-mails. The Integrity E-Mail AddIn must be installed. See further information below for installing Integrity E-Mail AddIn Install.

If the company would like the statement(s) to be sent from a ‘general payroll’ Outlook account and not from a payroll clerk’s personal Outlook account it is recommended to set up Multiple Outlook profiles.

Multiple Outlook Profile
Setting up a separate Network account and Outlook profile allows the company to send Employee Email Suite or E-Mail W-2 Statements through a ‘general payroll’ Outlook account instead of using the payroll clerk’s personal Network account and Outlook profile. Contact your IT Department for details on setting up a separate Network account and Outlook profile. Integrity Data does not support Microsoft Outlook functionality.

If the user creates a ‘general payroll’ Outlook profile it is important to verify Microsoft Dynamics GP is connected to the correct Outlook profile. The Employee Email Suite or E-Mail W-2 Statements will be sent from the Outlook profile connected to Microsoft Dynamics GP.

Integrity E-Mail AddIn Install
If Microsoft Outlook will be used to send the Employee Email Suite or the E-Mail W-2 Statements file to employees and track returned e-mails then the Integrity E-Mail AddIn is required for Employee E-mail Suite.

The AddIn file must be installed on the client machine sending the e-mails. This file enables the Trust Center Programmatic Access Security within Microsoft Outlook to function under the recommended settings. The user will no longer receive the message: A program is trying to send an e-mail message on your behalf. If this is unexpected, click Deny and verify your antivirus software is up-to-date.
Install Notes
Prior to installing:

- Confirm users are logged out of Microsoft Outlook
- The install can be ran as the administrator or as the user by right clicking and selecting run as administrator.

To install the Integrity E-Mail Addin the Addin must be downloaded from our [website](#) and installs processed on the Machine(s) sending e-mails.

1. Right click the Outlook Setup.exe file and select run as Administrator.
2. Complete the steps in the wizard.
License Agreement
Please carefully read the following license agreement.

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING THIS PROGRAM. USE OF THIS PROGRAM AND RELATED MATERIAL PROVIDED HEREWITH (HEREAFTER COLLECTIVELY REFERRED TO AS "PROGRAM") INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT WISH TO AGREE TO THESE TERMS AND CONDITIONS, CLICK "Cancel" AND PROMPTLY RETURN THE PACKAGE. YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THIS PROGRAM TO ACHIEVE YOUR INTENDED RESULTS, AND FOR THE INSTALLATION, USE, AND RESULTS OBTAINED FROM THIS PROGRAM.

TITLE: The PROGRAM is proprietary to Integrity Data of Illinois

I accept the terms of the license agreement

Destination Folder
Select folder where setup will install files.

Install Integrity Data Email Companion to:
C:\Program Files (x86)\Integrity Data Email Companion

Destination Folder
Required Disk Space: 130,140 bytes
Remaining Disk Space: 593,337 MB
3. Launch Microsoft Outlook.

4. Select File > Options > Addin

5. Validate the Integrity Email Companion Add-In is displayed under the Active Application Add-Ins.
Mail Server Setup

Employee E-mail Suite is designed to send mass amounts of e-mails. Ensure the mail server will allow the client to send the maximum amount of e-mails for the payroll process.

Microsoft Exchange Setups for Employee E-mail Suite

Employee E-mail Suite is designed to send mass amounts of e-mail. If the user is running Microsoft Outlook connected to a Microsoft Exchange Server then certain settings to the client Microsoft Outlook are needed to ensure all the desired e-mails are sent. Keep in mind that turning the cache off, the user cannot use the client junk mail filter for their anti-spam and the user will need to rely on their centralized network anti-spam application.

To adjust the settings within Microsoft Outlook:

1. Navigate to Tools > Account Settings
2. Double-click the Microsoft Exchange Name on the E-mail tab
3. Within the Change E-mail Account window unmark the “Use Cached Exchange Mode”
4. Select the More Settings… button

The user is not required to use Microsoft Exchange Server.

5. Within the Microsoft Exchange window, select the Connection tab
6. Unmark “Connect to Microsoft Exchange using HTTP” checkbox
7. Click OK to close the Microsoft Exchange window
8. Close the Change E-mail Account and Account Settings windows
9. Restart Microsoft Outlook
Set Up Adobe Writer for Employee E-Mail Suite

In order for the system to create the e-mail statements PDF file, the “Rely on system fonts only; do not use document fonts” option must be unchecked on the Adobe PDF Printing Preferences window. If the option is checked, the user will receive error messages and will not be able to send the e-mail statement PDF file. For steps to unmark this option, review our Knowledge Base article: http://www.integrity-data.com/faq-items/kb-prevent-postscript-error-message/.

Citrix and Adobe Acrobat

It must be noted that Adobe has a special deployment method for Citrix servers. If you are on a Citrix server verify with Adobe that it is correctly installed on your server. If it is not correctly installed, the product will not function properly. Please contact Adobe with any questions regarding the deployment on a Citrix server.

Registration

The system will automatically activate the product during the login process. If the activation was successful, the user will not receive any messages. However, if the activation process was unsuccessful the user will receive a message. If the activation process fails the user will need to open the Activation Manager window to activate the product.

Activation Manager Window

Microsoft Dynamics GP > Tools > Setup > System > Activation Manager

The Site Name defaults from the session information on the About Microsoft Dynamics GP window.

From the Product drop-down list the user may select the product they wish to activate and review product information. Once the product is selected the following fields will display:

- Installed Version – Current version number installed.
- Enhancement Plan Date – Date of the enhancement plan expiration.
- Activation Status – Current status of the product.
  - Permanent – Product has been purchased.
  - Trial – Product has been issued a trial period.
  - Deactivated – Product has been deactivated.
- Current Employees – This count defaults from the session information on the About Microsoft Dynamics GP window. The count does not include inactive employees or employees in a Test or Historical company. If the current employee count is incorrect validate Test or Historical companies are named correctly.
- Employees Allowed – The number of employees allowed before the product will be inactivated. If the Current Employees exceeds the Employees Allowed the system will deactivate the product.


The scrolling window contains a list of all companies. By default the product is active for all companies. If the user would like to inactivate a company unmark the company checkbox.

The Auto Activation option may be selected if the user receives a message at login stating the product is not activated. When the user selects the Auto Activation option the system will attempt to automatically activate the product. Once the Auto Activation process is complete the system will display the Activation Messages. For a detailed list of activation messages see the Activation Manager Messages section.

The Manual Activation option is used to manually enter a token. The user would only manually enter a token if they were sent a token by Integrity Data.

Select the OK button to close the window.

**Test and/or Historical Companies**

Registration will not count the active employees in Test or Historical company databases if the Company Name is named correctly, specifically at the end of the Company Name the user must append the following: "<TEST>" or "<HISTORICAL>". See examples below:

- Dextordinary, Inc. <TEST>
- Dextordinary, Inc. <HISTORICAL>

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified.
Security Settings

The Security Task Setup window may be used to grant or restrict access to the Employee E-mail Suite windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select Security Tasks and enter the system password.

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below:
   • Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > System > User Security), select the appropriate user and make a note of the Security Role ID assigned to the user.
   • Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > System > Security Roles), select the Role ID that has been assigned to the user and make note of the Security Task ID assigned to the Role. Use this Task ID to grant security to the Employee Email Suite.
     NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks

2. Select Employee E-mail Suite for the Product.
3. Select Windows for the Type and select 3rd Party for the Series.
4. Use the Access List to grant or restrict access to individual items.
   • To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark the item.
   • Click the Mark All button to grant access to all items in the list or click the Unmark All button to restrict access to all items in the list.
5. Click File > Print to print the Security Task Setup Report for the selected Task ID.
6. Choose OK to save your changes.

Employee E-mail Suite> Windows > 3rd Party > Access List
- 1095-C Export
- APR Main Menu
- E-Mail Earnings Statements
- E-Mail Suite Setup
- Password Setup
- Registration – EES
- APR Main Menu
- E-Mail W-2 Statements
- Manage W-2 Recipients

Employee E-mail Suite> Reports > 3rd Party > Access List
- Earnings Statement Exceptions
- EES 1095C Status Report
- EES Error Report
- EES Missing Email Report
- Earnings Statement Exceptions
- EES Error Report
• EES Missing Email Report
• E-Mail W2 Recipients
• E-Mail W2 Statements
• W-2 Employee Copy 2
• W-2 Employee Copy B
• W-2 Employee Copy C
• W-2 Employee Copy D
Direct Deposit Setup

Microsoft Dynamics GP > Tools > Setup > Payroll > Direct Deposit

The Earnings Statement Print option on the Direct Deposit Setup window needs to be set to “Separate From Checks” in order for E-Mail Earnings Statements to function properly.
Introduction to Employee Email Suite

Organizations are increasingly moving toward payroll processing using Direct Deposit. The E-Mail Earnings Statements extends the payroll process functionality of Microsoft Dynamics GP to support the e-mailing of Earnings Statements as an added option during the print checks portion of the payroll process.

The system will allow the user to:

- Specify setup options for employees to receive e-mail earnings statements;
- Add employees to an E-Mail Exceptions Report;
- Password protect the e-mailed earnings statements (up to 15 characters);
- Validate employees address ID on the Missing E-Mail List Report;
- Generate individual earnings statements for employees and
- E-Mail the statements to employees.

The user will complete the following setup options:

- E-Mail Configuration information
  - E-Mail Method
  - Subject Line
  - E-Mail Body
  - Blind Carbon Copy
  - Password
  - PDF file location
- Employee Exceptions
  - Employee ID
  - Employee Name
  - E-Mail Address

E-Mail Earnings Statements will process if the following conditions are met:

- The Employee E-Mail Suite is installed and registered;
- The user has selected the Activate E-Mail Earnings Statements checkbox;
- The employee has an e-mail address assigned on the Internet Information window;
- Direct deposit must be active and setup for the employee and
- The employee must be included in the payroll run and not appear on the Exception List Report.
**Internet Information Window**

Cards > Payroll > Employee > Select Employee > Address ID Field > Internet Addresses button

The Internet Information window allows the user to enter one or more e-mail addresses for each employee based on an address ID. Employee E-mail Suite will only use the e-mail address that is associated to the address ID code that is in the Address ID field on the Employee Maintenance window.

If the Address ID on the Employee Maintenance window is not associated with an e-mail address on the Internet Information window, the employee will appear on the Missing E-Mail List Report.

---

**Assign an E-Mail Address to an Address ID**

- Select the Internet Addresses button on the Employee Maintenance window
- Enter the E-mail address in the E-mail field, within the Internet Information section
- Save and validate the Address ID on the Employee Maintenance window
Assign Multiple E-Mail Addresses to an Employee

If an employee has more than one e-mail address, the E-Mail Earnings Statement will only be e-mailed to the address ID defined on the Employee Maintenance window. The following is specifics on how multi e-mail addresses process.

For example, Ackerman has two address IDs, one PRIMARY and one SECONDARY. Within the Internet Information window, the address IDs are as follows:

- PRIMARY Address ID = e-mail address ackerman@fabrikam.com
- SECONDARY Address ID = e-mail address pilarackerman@testcompany.com

In the above Employee Maintenance window, Ackerman has the PRIMARY Address ID selected. At the time the E-Mail Earnings Statements sends the e-mail, the system will use the e-mail Address associated to the PRIMARY Address ID that is ackerman@fabrikam.com.

If the employee wants the E-Mail Earnings Statements sent to pilarackerman@testcompany.com, the user must change the Address ID to SECONDARY on the Employee Maintenance window, NOT on Internet Information window.

When using Microsoft Outlook as your e-mail method, if the employee wants their Earnings Statement sent to multiple e-mail addresses, it is an option to enter both addresses into the e-mail field separated by a semi-colon. An example of this would be packerman@fabrikam.com;packerman@live.com.
E-Mail Suite Setup Window

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup

Use the E-Mail Suite Setup window to complete the settings for E-Mail Earnings Statements. Use the Product Option drop-down list to select E-Mail Earnings Statements. This window also gives the user capability to enable or disable the selected product.

Activate

Use the Activate checkbox to enable or disable the selected product. If the Activate checkbox is not marked the user will not be able to process E-Mail Earnings Statements.

E-Mail Method

Use the E-Mail Method drop-down list to select the e-mail method. The options are Outlook or SMTP.

- If Outlook is selected the system will use the Microsoft Outlook profile as defined on the payroll user's machine.
- If SMTP is selected the user does not have to use a Microsoft Outlook account to send the e-mails. Rather, the system will connect directly to an SMTP server for sending e-mails. The user must complete the SMTP Settings section.
SMTP Settings

- Outgoing Server – specify the SMTP server the system will use to send the e-mails, this is a required field.
- Outgoing Port – specify the Port the system will use to send the e-mails, this is a required field. For SSL use port 587 and select the Enable SSL/TLS checkbox.
- Authentication – select the appropriate option from the drop-down list:
  - None – a user can connect to the SMTP server without credentials.
  - Current User – the system will use the credentials of the user currently logged into Windows to connect to the SMTP server.
  - Custom – the system will use the user name and password specified on the E-Mail Suite Setup window to connect to the server. If Custom is the option selected for Authentication, enter a Username and Password.
- Reply-To Address – enter an address that can be a general payroll e-mail account that is setup on the server, this is a required field.
- Reply Name – enter a name that can be a general name such as Payroll Administrator, this is a required field.
- Verify SMTP – Select to send a test email to the reply to address. If the SMTP settings are correct the email address in the Reply To Address will receive the test email and the Verify SMTP message will state successful.

E-Mail Configuration section

The system will generate an e-mail using the default profile settings in Microsoft Outlook or using the SMTP setup options on the E-Mail Suite Setup window.

- Subject line – enter a subject for the e-mail not exceeding 100 characters, this is a required field.
- Blind Carbon Copy – enter a blind carbon copy if desired. This allows the user to keep a copy of the e-mail.
  - When using Microsoft Outlook as your E-Mail method, if there is a need to set multiple e-mail addresses, it is an option to enter both addresses into the Blind Carbon Copy field separated by a semi-colon. An example of this would be packerman@fabrikam.com;packerman@live.com.
- E-Mail Body – enter an e-mail body not exceeding 253 characters.

Here is a KB article on other considerations for Employee E-Mail Suite setup. [http://www.integrity-data.com/faq-items/kb-employee-email-suite-setups-considerations-to-improve-processing-speed/]
Options

- **Password** – the system will assign a password to the earnings statement PDF file attached to the e-mail. During the setup, the user needs to select one of the three options or create a custom password:
  
  o **None** – No password will be assigned to the attached earnings statement PDF file.

  o **Last 4 of the Employee Social Security Number** – The attached earnings statement PDF file will require the employee to enter in the last 4 digits of their Social Security Number to open the attachment.

  o **First 5 of the Employee Social Security Number** – The attached earnings statement PDF file will require the employee to enter in the first 5 digits of their Social Security Number to open the attachment.

If the user selects a password option within the E-Mail Suite Setup window, they must notify the employee a password will be required to view their e-mail earnings statements PDF file. When notifying the employee of the password clarify which option has been selected within the password field on the E-Mail Earnings Statement window.

**Tips on How to Notify Employees:**

- Include the password notification in the e-mail body on the E-Mail Suite Setup Statement window.

- Notify employees prior to sending the e-mail earnings statements.

When the employee opens their E-Mail Earnings Statements PDF file, they will receive a password message asking them to enter their password. *This message does NOT inform the employee the Password option selected.*

Employee PDF File Location – the naming convention for the PDF file will be “XXXX.pdf”, where XXXX is defined as the employee ID. If an invalid path is entered, the system will display an error message stating, “Please select a valid PDF file location path.”

Include E-Mailed Earnings Statements when printing:
• Mark this checkbox if the user would like to have a printed copy of the e-mailed earnings statement. The system will print the e-mailed statements during the Print Earnings Statements process on the Post window.
• Unmark this checkbox if the user does not want the e-mailed earnings statements to print during the Print Earnings Statements process on the Post window.

Archive E-Mailed Earnings Statements:

• Mark this checkbox if the user would like to have a copy of the e-mailed earnings statement PDF file saved. The system will create a folder with the Audit Trail Code as the label in the Employee PDF File Location. After sending the PDF files the system will copy the PDF files into the Audit Trail Code folder before deleting the PDF files from the Employee PDF File Location.
• Unmark this checkbox if the user does not want to have a copy of the e-mailed earnings statements PDF file saved.

Missing E-Mail List Button

The Missing E-Mail List Button allows the user to print the Missing E-Mail List Report which contains the employees who do not have an E-Mail address associated the Address ID on the Employee Maintenance window. The employees on this list will not receive an E-Mail Earnings Statement.

Employee Exception List Button

The Employee Exception List button allows the user the ability to add employees to an exception list. If an employee decides they do not wish to receive e-mailed earnings statements then the user can enter the employee into the exceptions list window. Employees who are added to this list will NOT receive an e-mailed earnings statement.

Enter an Employee ID within the Employee Exception List scrolling window. If an Employee ID is entered into this window and the employee does not exist in the system, the user will be able to add the employee.

The Employee Name and E-Mail Address pre-fills from the Employee Maintenance window.

To delete an Employee ID from the exception list, select the Employee ID and then click the Delete Row button.
Select the window level printer icon to print the E-Mail Exceptions Report.
E-Mail Earnings Statements Reports

Missing E-Mail List Report

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup > Missing E-Mail List

The user can print the Missing E-Mail List Report by selecting the Missing E-Mail List button on the E-Mail Suite Setup window. The Missing E-Mail List Report contains employees who do not have an e-mail address associated with the Address ID on the Employee Maintenance window.

The user may use this report to verify the employees have an e-mail address assigned to the Address ID. If an Employee appears on this list, they do not have an e-mail address for the Address ID listed on the Employee Maintenance window. It is suggested that the payroll clerk prints this report before processing payroll.
E-Mail Exceptions Report

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup > Employee Exception List

The user can print the E-Mail Exceptions Report by selecting the Employee Exception List button on the E-Mail Suite Setup window. This report contains the Employee ID, Employee Name and E-Mail Address for the employees who have been added to the Employee Exceptions List. Employees who are on this report will NOT receive an e-mailed earnings statement.

<table>
<thead>
<tr>
<th>Employee ID</th>
<th>Employee Name</th>
<th>E-Mail Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACKE0001</td>
<td>Ackerman, Pilar</td>
<td><a href="mailto:mmorris@integrity-data.com">mmorris@integrity-data.com</a></td>
</tr>
</tbody>
</table>
Password Setup

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup > Expand button

The user can setup custom passwords for a select few employees or all employees. To access the Password Setup window select the expand button to the right of the Password field on the E-Mail Suite Setup window. If an employee is listed in the Password Setup window, the system will override the option selected for the Password in the drop-down list on the E-Mail Suite Setup window. The user does not need to validate each employee has a unique password. When the user has E-Mail W-2 Statements and E-Mail Earnings Statements registered, the custom password will be the same within both products.

Enter an Employee ID within the Custom Password scrolling window. If an Employee ID is entered into this window and the employee does not exist in the system, the user will be able to add the employee.

The Employee Name pre-fills from the Employee Maintenance window.

To delete an Employee ID from the exception list, select the Employee ID and then click the Delete Row button.

Enter a Password not exceeding 15 characters.
E-Mail Earnings Statements Process

Transactions > Payroll > Email Earnings Statements

Once the Post process during payroll has been completed, open the E-Mail Earnings Statements window. The user will select the payroll build and then the system will display the earnings statement details for the build. The user can then mark all or select which employee’s need to be e-mailed.

The system will prevent a user from running a Payroll if E-Mail Earnings Statements are being processed. The system will prevent a user from processing E-Mail Earnings Statements if a Payroll is in process.

If the user has additional company-wide PDF files to send with the employee’s e-mail earnings statements, they can include the file(s) in the EES folder located in the C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\EES folder. These files will be attached to the employee’s e-mail and sent to ALL employees.

Sending Employee Specific attachments

If the user has employee specific files to send, such as a time sheet, with the employee’s e-mail earnings statements, they can include the file(s) in the Employee folder located in the C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\EES folder. The system will only send a file to an employee if the file is named with the employee ID followed by two single quotes. For example, if an Excel document was named ACKE0001” Timesheet.xlsx and saved in the \Data\EES\Employee folder when the system sends ACKE0001 their earnings statement the system will send this Excel document.

IMPORTANT: Do not set the Employee PDF File Location on the E-Mail Suite Setup window to this folder. The files included in this folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\EES) will be sent to ALL employees!
Blind Carbon Copy – displays the Blind Carbon Copy specified on the E-Mail Suite Setup window. If a change is needed to the Blind Carbon Copy field, select the Email Setup button.

E-Mail Subject – displays the subject from the E-Mail Suite Setup window. If a change is needed to the E-Mail Subject line, select the Email Setup button.

E-Mail Body – displays the e-mail body from the E-Mail Suite Setup window. If a change is needed to the E-Mail Body, select the Email Setup button.

Build Information Scrolling window – displays the Created By user, Audit Control number, Check Date, Build ID and Gross Wages. Select the batch you wish to process and the employees will display in the Employee Detail Scrolling window.

Restrictions – enables the user to restrict the Employee Detail Scrolling window by Employee, Employee Class, Department and Division.

Employee Detail Scrolling window – displays the employees from a specific build, which would receive e-mail earnings statements. The payroll clerk selects the employees who are to receive the e-mail earnings statements.

The system will leverage the existing Adobe Acrobat Writer software on the local machine to create the PDF files. If a user receives an Adobe error message while processing e-mail earnings statements they will need to contact Adobe directly to troubleshoot the error message.
PDF File Location

The system will confirm whether the value for the PDF file location path as defined in E-Mail Suite Setup window represents a valid path for the current machine. If the path is invalid, the system will display a warning and prevent the user from continuing the E-Mail Earnings Statements process until a valid path is specified.

If the user receives an invalid PDF file location path error message, select ok. Then open the E-Mail Suite Setup window.

Select a valid PDF file location and then click OK on the E-Mail Suite Setup window.

Reselect the Employee ID(s) on the E-Mail Earnings Statements window and click Process.

A PDF will be generated for each employee’s earnings statement.
Create E-Mail Earnings History

Microsoft Dynamics GP > Tools > Utilities > Payroll > Create E-Mail Earnings History

Use the Create E-Mail Earnings History to import batches, which were ran without the Employee Email Suite into the Email Earnings Statements window. The system will import employees, which are setup with Direct Deposit and have an email address on the Internet Information window into the Email Import Batch. Once the batch is imported then the user can email those past payrolls to employees.
E-Mail Statements Error Report

The system will generate a report after processing the earnings statements. The report will specify if there was an error or if the system sent the e-mails successfully. Only errors reported back to Microsoft Dynamics GP will be included on the report. The report contains the Employee ID and Error Message.

Depending on the number of statements the user is trying to e-mail and the speed of the system processing the e-mail, the process may run for an extended period of time.

The user will need to manually track errors such as returned e-mails within Microsoft Outlook from the system that processed the E-Mailed Earnings Statements. This information can then be updated in Microsoft Dynamics GP and the statements can be resent from the E-Mail Earnings Statements window.
Introduction to E-Mail W-2 Statements

Organizations are increasingly moving towards electronic communication. A new benefit a company can implement is the option to receive the Form W-2 electronically.

The E-Mail W-2s product:

- Provides access to W-2 statements earlier than traditional mail;
- Greatly reduces the chance that a W-2 statement will get lost, misdirected or delayed during delivery or misplaced after the employee receives it;
- Ensures employees can receive W-2 statements even while traveling or away from their mailing address;
- Allows employees to retrieve their W-2 statements at any time of day and on weekends;
- Allows employees to print multiple copies of their W-2 statement and
- Helps employees contribute to their employer’s cost savings (forms, printing and postage expenses).

The system will allow the user to:

- Specify setup options for employees to receive e-mail W-2 statements;
- Generate individual W-2 statements for employees;
- E-Mail W-2 statements to employees and
- Archive W-2 statements for employees.

The user will complete the following setup options:

- E-Mail Configuration information
  - E-Mail Method
  - Subject Line
  - Blind Carbon Copy
  - E-Mail Body
  - Password
  - Employee PDF file location
  - Employer PDF file location
  - Enable archiving for W-2s
- Manage W-2 Recipients
E-Mail W-2 statements will process if the following conditions are met:

- The Employee E-Mail Suite is installed and registered.
- The user has selected the Activate E-Mail W-2 Statements option.
- The employee has an e-mail address assigned on the Internet Information window.
- The employee is marked to receive an e-mail on the Manage W-2 Recipients window.
- The system has at least one Year-End Wage File.

E-Mail W-2 statements will process in the following order:

- Perform a pre-check operation.
- Create a distinct W-2 statement for each employee designated to receive e-mail W-2s.
- Generate the W-2 form as a password protected PDF file.
- E-Mail the W-2's to employees who are setup to receive them.

**Timeline for Electronic W-2 Statement Delivery**

Please note that employers must furnish electronic Forms W-2 by the same due date as paper Forms W-2. For more information on furnishing Form W-2 to employees electronically, see Regulations section 31.6051-1(j).

**Regulations Surrounding Electronic Delivery of W-2 Statements**

E-Mail W-2 statements for Microsoft Dynamics GP creates Electronic W-2s according to the requirements set forth in IRS Publication 1141 Section 2, titled, *Requirements for Substitute Forms Furnished to Employees (copies B, C, and 2).*

According to IRS Publication 15a, *Employers Supplemental Tax Guide*, in order to e-mail W-2 Statements:

- Each employee participating must consent electronically (or receive confirmation of any consent made using a paper document);
- Employers must notify employees of all hardware and software requirements to receive the forms;
- Employers may not send a Form W-2 electronically to any employee who does not consent or who has revoked consent previously provided; and
- Employers must meet the following disclosure requirements and provide a clear and conspicuous statement of each of them to employees:
1. The employee must be informed that he or she may receive a paper Form W-2 if consent is not given to receive it electronically.

2. The employee must be informed of the scope and duration of the consent.

3. The employee must be informed of any procedure for obtaining a paper copy of any Form W-2 (and whether or not the request for a paper statement is treated as a withdrawal of his or her consent) after giving consent.

4. The employee must be notified about how to withdraw consent and the effective date and manner by which the employer will confirm the withdrawn consent. The employee must also be notified that the withdrawn consent does not apply to the previously issued Forms W-2.

5. The employee must be informed about any conditions under which electronic Forms W-2 will no longer be furnished (for example, termination of employment).

6. The employee must be informed of any procedures for updating his or her contact information that enables the employer to provide electronic Forms W-2.

7. The employer must notify the employee of any changes to the employer’s contact information.
E-Mail Suite Setup Window

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup

Use the E-Mail Suite Setup window to complete the settings for E-Mail W-2 Statements. Use the Product Option drop-down list to select E-Mail W-2 Statements option. This window also gives the user capability to activate or inactivate the selected product.

Activate

Use the Activate checkbox to enable or disable the selected product. If the Activate checkbox is not marked, the user will not be able to process E-Mail W-2 Statements.

E-Mail Method

Use the E-Mail Method drop-down list to select the E-Mail method. The options are Outlook and SMTP.

- If Outlook is selected the system will use the Microsoft Outlook profile as defined on the payroll user’s machine.
- If SMTP is selected the system will not use the Outlook profile as defined on the payroll user’s machine to send the E-Mails. The system will connect directly to an SMTP server for sending E-Mails. The user must complete the SMTP Settings fields. For SSL use port 587 and select the Enable SSL/TLS checkbox.

SMTP Settings
o Outgoing Server – specify the SMTP server the system will use to send the E-Mails, this is a required field.

o Outgoing Port – specify the port the system will use to send the E-Mails, this is a required field.

o Authentication – select the appropriate option from the drop-down list.
  - None – a user can connect to the SMTP server without credentials.
  - Current User – the system will use the credentials of the user currently logged into Windows to connect to the SMTP server.
  - Custom – the system will use the user name and password specified on the E-Mail Suite setup window to connect to the server. If Custom is the option selected for authentication, enter a username and password.

o Reply-To Address – enter an address which can be a general payroll e-mail account which is setup on the server, this is a required field.

o Reply Name – enter a name that can be a general name such as payroll administrator, this is a required field.

o Verify SMTP – Select to send a test email to the reply to address. If the SMTP settings are correct the email address in the Reply To Address will receive the test email and the Verify SMTP message will state successful.

E-Mail Configuration section

The system will generate an e-mail using the default profile settings in Microsoft Outlook or the SMTP Settings on the E-Mail Suite Setup window.

- Subject Line – enter a Subject Line not exceeding 100 characters; this is a required field.

- Blind Carbon Copy – enter a Blind Carbon Copy if desired. This allows the user to keep a copy of the e-mail to resend, if necessary.

- E-Mail Body – enter an e-mail body not exceeding 253 characters.

Options

- Password – the system will assign a password to the W-2 Statement PDF file attached to the e-mail. During the setup, the user needs to select one of the three options or create a custom password:
  - None – No password will be assigned to the attached W-2 Statement PDF file.
  - Last 4 of the Employee Social Security Number – The attached W-2 Statement PDF file will require the employee to enter in the last 4 digits of his or her Social Security Number to open the W-2 Statement PDF file.
  - First 5 of the Employee Social Security Number – The attached W-2 Statement PDF file will require the employee to enter in the first 5 digits of his or her Social Security Number to open the W-2 Statement PDF file.
Custom: The user can assign a custom password for select employees or all employees by using the Password Setup window. For more details see the Password Setup window section of this user documentation.

If the user selects a password option within the E-Mail Suite Setup window, he must notify the employee a password will be required to view his e-mail W-2 Statement PDF file. When notifying the employee of the password, clarify which option has been selected within the Password field on the E-Mail Suite Setup window.

Tips on How to Notify Employees:

- Include the password notification in the E-Mail body on the E-Mail Suite Setup Statement window.
- Notify employees prior to sending the E-Mail W-2 Statements.

When the employee opens the E-Mail W-2 Statements PDF file, the system will prompt a password message asking to enter the password. This message does NOT inform the employee the password option selected.

Employee PDF File Location – the naming convention for the PDF file will be “XXXX-Copy-W2.pdf”, where XXXX is defined as the Employee ID. This file will contain the forms that were selected in the Options section on the E-Mail W-2 Statements window. If an invalid path is entered, the system will display an error message:

Employer PDF File Location – the naming convention for the PDF file will be “XXXX-W2.pdf”, where XXXX is defined as the Year. If an invalid path is

It is best practice to empty the PDF file location once the e-mails have been sent. The user may select the archive option to store the PDF W-2 Statements. Clearing out this PDF file location will prevent the previous W-2 Statements from being sent in the occasion the E-Mail W-2 Statements process is not able to create the new W-2 Statement PDF files.
entered, the system will display an error message:

![Error Message](Image)

**Archive W-2’s**

Use the Archive W-2’s checkbox to automatically create an archive folder for the selected year on the E-Mail W-2 Statements window. The folder will be created in the Employee PDF file location. This folder will contain the most current PDF file for the selected year.

**Missing E-Mail List Button**

The Missing E-Mail List Button allows the user to print the Missing E-Mail List Report which contains the employees who do not have an e-mail address associated the Address ID on the Employee Maintenance window. The employees on this list will not receive an E-Mail W-2 Statement.
Manage W-2 Recipients

The Manage W-2 Recipients button opens the Manage W-2 Recipients window and allows the user to select which employees are to receive the e-mailed W-2 Statements. If the user has received permission from an employee to e-mail the W-2 statement, the user will mark the E-Mail W-2 checkbox. If the user has NOT received permission from an employee to e-mail the W-2 statement, the user will NOT mark the E-Mail W-2 checkbox.

The user has three options to populate the scrolling window with employees:

1. Click the Redisplay button to populate the scrolling window with ALL employees.
2. Use the Restrictions to define by Employee ID, Employee Class, and/or Department. You can also display only active or inactive employees. You can also exclude employees who do not have an email address in the Internet Information window.
3. Enter or select an Employee ID within the Employee ID field.

The Employee Name pre-fills from the Employee Maintenance window.

The Alternate E-Mail Address field allows the user to enter an alternate e-mail address for the employee.

Use E-Mail W-2 checkbox to select which employees are to receive the E-Mailed W-2 Statement.

Select the window level printer icon to print the E-Mail W-2 Recipients Report.
E-Mail W-2 Statement Reports

Missing E-Mail List Report

Microsoft Dynamics GP > Tools > Setup > Payroll > E-Mail Suite Setup > Missing E-Mail List

The user can print the Missing E-Mail List Report by selecting the Missing E-Mail List button on the E-Mail Suite Setup window. The Missing E-Mail List Report contains employees who do not have an e-mail address associated with the Address ID on the Employee Maintenance window.

The user may utilize this report to verify the employee has an e-mail address assigned to the Address ID. If an employee appears on this list, they do not have an e-mail address for the Address ID listed on the Employee Maintenance window. It is suggested that the user prints this report before processing the W-2 Statements.
E-Mail W-2 Recipients Report
Cards > Payroll > Manage W-2 Recipients

The user can print the E-Mail W-2 Recipients Report by selecting the window level printer icon on the Manage W-2 Recipients window. The E-Mail W-2 Recipients Report contains the details from the Manage W-2 Recipients window.

The user may utilize this report to verify that all employees who elected to have the E-Mail W-2 Statement e-mailed to them have the E-Mail W-2 checkbox marked. It is suggested that the user prints this report before sending the E-Mail W-2 Statements.
E-Mail W-2 Statements Window

Microsoft Dynamics GP > Tools > Routines > Payroll > E-Mail W-2 Statements

The user will have the ability to e-mail W-2 Copy B, W-2 Copy C and W-2 Copy 2 Forms for a specific year-end wage file. The system will display the employees who will receive an E-Mail W-2 Statement within the scrolling window.

If the user has additional company-wide PDF files to send with the employee’s E-Mail W-2 Statement, they can include the PDF file(s) in the W2-Attach folder located in the C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data folder. These files will be attached to the employee’s email and sent to ALL employees.

The E-Mail W-2 Statements product automatically places the W-2 Instruction File.pdf file in the W2-Attach folder. Once the system sends the e-mail, the W-2 Instructions.pdf file will be attached to the e-mail along with the W-2 Form(s).

**IMPORTANT:** Do not set the Employee PDF File Location on the E-Mail Suite Setup window to this folder. The files included in this folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Data\W2-Attach) will be sent to ALL employees!
Year – select the year for which W-2s will be printed. The drop-down list is populated with the same years that are available to the system from the Print W-2s form process.

Report Year – Displays the current report year format which will be emailed to the employee. The Year and Report year should be the same. The report is updated yearly in November/December and a new version will need to be installed each year as part of the year end process.

Company, Address ID, Address, City, State, ZIP Code – displays from the Company Setup window. The user may change the Address ID if needed.

Subject Line – displays from the E-Mail Suite Setup window. If a change is needed to the Subject Line, select the E-Mail Setup button to open the E-Mail Suite Setup window.

E-Mail Body – displays from the E-Mail Suite Setup window. If a change is needed to the E-Mail Body, select the E-Mail Setup button to open the E-Mail Suite Setup window.

Blind Carbon Copy – displays the Blind Carbon Copy specified on the E-Mail Suite Setup window. If a change is needed to the Blind Carbon Copy field, select the E-Mail Setup button.

Employer Identification Number – displays the company's employer ID for which wages were reported during the year. This number is assigned by the federal government and is the number entered using the Unemployment Tax Setup window. Changes may be made, if necessary.

Options – when the user processes E-Mail W-2 Statements, they have the option to create one PDF file which contains only the e-mailed W-2 Statements or create one PDF file which includes both the e-mailed W-2 Statements and the hardcopy W-2 Statements.

Save an employer copy – mark this checkbox to create one employer copy PDF file for the employees receiving E-Mail W-2 Statements. Marking this checkbox enables the "Include printed W-2 employees" checkbox.

Include printed W-2 employees – mark this checkbox to create one employer copy PDF file including all employees receiving a W-2 Statement via e-mail or hardcopy.

Forms – allows the user to select which W-2 forms will be processed during the E-Mail W-2 Statements process.

- W-2 Copy B
- W-2 Copy C
- W-2 Copy 2

Employee Detail Scrolling window – displays all the employees or the specified employees from the From/To fields. The Employee ID, Employee Name and E-Mail Address displays from the Employee Maintenance window or the Manage W-2 Recipients window.
E-Mail W-2 Statements Process

When the user selects the Process button, the system will leverage the existing Adobe Acrobat Writer software on the local machine to create the PDF files. If a user receives an Adobe error message while processing E-Mail W-2 Statements they will need to contact Adobe directly to troubleshoot the error message.
PDF File Location

The system will confirm whether the value for the PDF File Location path as defined in E-Mail Suite Setup window represents a valid path for the current machine. If the path is invalid, the system will display a warning and prevent the user from continuing the E-Mail W-2 Statements process until a valid path is specified.

If the user receives an invalid PDF file location path error message, select OK. Then open the E-Mail Suite Setup window.

1. Select a valid PDF file location and then click OK on the E-Mail Suite Setup window.

A PDF will be generated for each employee’s W-2 statement and placed in the directory specified in E-Mail Suite Setup window. The PDF will remain in this directory until the E-Mail W-2 Statements is processed again.

E-Mail Validation

The system will confirm that each employee has a valid e-mail address. If one or more e-mail addresses are missing for an employee, the system will prompt message, “One or more email addresses are missing for employees. If you continue, W-2 statements will not be sent to those employees.” The user may choose Continue, Cancel or Print.
Click Continue to proceed with the E-Mail W-2 Statement process. Keeping in mind that the E-Mail W-2 Statements cannot be sent to the employee who does NOT have an e-mail address; however, if a blind carbon copy is setup for this employee, the file will be sent to the e-mail address specified in the blind carbon copy field.

Click Cancel to close the message and the user may update the employee e-mail address.

Click Print to print the Missing E-Mail List Report. The user may utilize this report to update the employee e-mail address.
E-Mail Statements Error Report

The system will generate an E-Mail Statements Error Report after processing the E-Mail W-2 Statements. The report will specify if there was an error or if the system sent the e-mails successfully. *Only errors reported back to Microsoft Dynamics GP will be included on the report.* The report contains the Employee ID and Error Message.

Depending on the number of W-2 forms the user is trying to e-mail and the speed of the system processing the e-mail, the process may run for an extended period of time.

The user will need to manually track errors such as returned e-mails within the system that processed the E-Mailed W-2 Statements. This information can then be updated in Microsoft Dynamics GP and the W-2 forms can be reprocessed from the E-Mail W-2 Statements window.
Print W-2 Statements Window

Microsoft Dynamics GP > Tools > Routines > Payroll > Print W-2s

The user will be able to print the W-2 statements before or after e-mailing the W-2 statements. The system will allow the user to decide to either print all W-2 statements or print only the employees who elected to not receive an e-mail W-2 statement. Once the user selects the print button on the Print W-2 Forms window the system will prompt message, “Do you wish to exclude employees who receive emailed W-2 statements?” The user may choose Yes or No.

Click No to print all employees including the ones who elected to receive an E-Mail W-2 Statement.

Click Yes to print only employees who elected to receive a printed W-2 Statement.
Sample Employee E-Mail and PDF Consent Form

Sample E-Mail
The following e-mail is an example only and uses the disclosure requirements set forth in IRS Publication 15a and Treasury Regulations Sub Chapter C. Sec 31.6051-1(j).

Email Subject: IMPORTANT TAX RETURN DOCUMENT AVAILABLE

Email Body:
Fabrikam is pleased to offer W-2 statements via e-mail this year instead of the traditional paper copy! Benefits to receiving your W-2 by e-mail are:

(List all benefits – link to list of benefits below).

Please read the attached PDF file for instructions on how to consent to this process and for important information regarding electronic delivery of your W-2. If you are unable to read the attached PDF file, please contact … or download … (with link)

You may decline the electronic W-2 and continue to receive a paper copy of your W-2 by either not replying or by replying and stating:

“I do not want to receive my W-2 electronically.”
Sample PDF Consent Form
The following text is an example only for a PDF consent form.

If you would like to receive your W-2 by e-mail, you must reply to this message and place the following text in your reply:

“"I agree to accept my W-2 statement electronically at this e-mail address." (Or, you may specify a different e-mail address).

You may decline the electronic W-2 and continue to receive a paper copy of your W-2 by either not replying or by replying and stating:

“"I do not want to receive my W-2 electronically."

Please note you will receive a paper copy of your W-2 unless you specify differently prior to 01/15/2016. Consent is for one year only and consent will be required again next year.

You may revoke your consent for an electronic W-2 delivery prior to January 15, 2016 by contacting the payroll department at w2consent@Fabrikam.com or at 555-555-5555, ext. 555. Withdrawing consent by January 15, 2016 will be for this year only and does not apply to any W-2 documents you have already received.

Conditions under which W-2s will no longer be furnished electronically may include:

(List all reasons - for example, termination of employment).

E-Mail addresses used for electronic delivery may be changed prior to January 15, 2065 by contacting the payroll department at w2consent@Fabrikam.com or at 555-555-5555, ext. 555.

When you receive your W-2 electronically, it will be attached to an e-mail as a PDF file – much like the one you are currently reading. You will need PDF reading software (such as Adobe Acrobat Reader) and the hardware necessary to run the PDF reader software. If you are reading this on your own computer after having opened this attached via your e-mail then you meet the hardware and software requirements for receiving your electronic W-2.
Introduction to E-Mail 1095-C

The Email 1095-C functionality gives the user the ability to send the 1095-C to employees electronically. The E-Mail 1095-C functionality is available in our hosted web solution only. This functionality is not available within Microsoft Dynamics GP although we have a Microsoft Dynamics GP process for pushing the 1095-C data to the hosted solution. You will need to login to the cloud services solution and upload your employees before you try to sync your data.

Step 1: Login

Although we have SQL scripts to help users gather required information already setup in Microsoft Dynamics GP.

An email is sent with an invite to login to the Email 1095-C Solution. When you receive the email from CloudServices@integrity-data.com in your inbox click the link within this email to login. If you have not received this email, check your junk or spam folders for the invite.

After selecting the link to login, a web Browser will open to a login screen. You may authenticate your login by using a Microsoft Live account or a Google account. If you do not have these types of accounts, you can create an account. There is no cost to create the Microsoft Live or Goggle the account.
Step 2: User Management

The ACA Compliance Solution begins with a single admin user, which was defined during the initial onboarding process upon purchase of the product. The example below shows this condition for Wilbur Consulting:

For an existing user, the name, phone number, and email fields are all editable. You can add another user by clicking “Add User” in the grid header region. The creation of a user alone does not mean they will have access to the system. You will need to send an invitation to the user by clicking the “Invite” button. This will send an email to the user’s specified address and allow them to click a link establishing their credentials to log into the ACA Compliance Solution. Establishing their credentials means that the user will need to select an authentication provider (currently Google accounts or Microsoft live accounts are supported). Please note that the invitation itself can be sent to any email address but the actual login credentials themselves are tied to the aforementioned authentication provider.

For example: Sebastian Farnsworth has an email address of sfarns@integrity-data.com and that is where the email invite was sent. Once Sebastian checked his email and clicked on the invitation embedded in the email invite, he was prompted to select an authentication provider. It is at this point that Sebastian will need to provide Google or Microsoft credentials to log into the ACA Compliance Solution.

⚠️ NOTE: It is advisable to create at least one more user and invite them to the ACA Compliance Solution as soon as possible after logging into the solution for the first time. This will ensure that there is at least one other user of the system in the event that a problem arises with the initial user, eg… technical issue or user leaves the company etc…
Step 3: Standard Measurement Period

The system requires setting up the standard measurement period before filling out the company information.

Employers are permitted to determine an employee’s full-time status based on a measurement period established by the employer of up to 12 consecutive months but no less than 3 months. During the measurement period, an employer is not subject to an excise tax payment with respect to, among others, new “variable-hour” employees.

Employees determined to be full-time during a standard measurement period must be offered coverage during a corresponding “stability period” of the same length even if their hours drop below full-time, provided they remain employed.

The standard measurement period applies to employees when, on their date of hire, it was undetermined if they would meet the full-time requirement of working at least 30 hours a week. This period allows for what is sometimes called a “look-back” period where the employee will be tested to see if they meet full-time status.

In an effort to provide flexibility to employers, an employer can have different measurement and stability periods for four categories of employees:

1. Employees located in different states
2. Salaried and hourly employees
3. Employees of different entities
4. Collectively bargained employees and non-collectively bargained employees

You can set up multiple standard measurement periods as defined above using the standard measurement period setup page. The system allows for either one default standard measurement period or multiple periods defined by location and type of employee.
Period
You can select an existing period ID or create a new one by typing a name into the “New Period” field. This is a unique name for this standard measurement period. You can have multiple standard measurement periods.

Employment Type
Drop-down list that includes:
- ALL – All employees are included in this Period ID.
- SALARY – Only salaried employees are included in this Period ID.
- HOURLY – Only hourly employees are included in this Period ID.

State
The ACA allows you to have different standard measurement periods by location (States).

This drop down list contains the State abbreviations applicable for your employees. (Derived from transactions and employee maintenance records) You can choose to select individually or include ALL.

Close Period
This feature reserved for a future release

Start of Measurement Period
You can start your measurement period as of the hire date or the first day of the next month. In most cases, you will select Using First Day of Next Month. This is used to determine who is to be included in the standard measurement period testing.

Standard Measurement Period
Input the start date for your measurement period. Input the number of months in your period. The end date will automatically calculate.

Administrative Period
Some employers may want to have an “administrative period” between the end of the standard measurement period and the beginning of the stability period in order for paperwork to be processed. The administrative period cannot exceed 90 days.

If you have an administrative period, input the start date of the administrative period and the number of months. ACA Compliance Solution will not allow you to enter more than 3 months.

Stability Period
Employees determined to be full-time during a measurement period must be offered coverage during a corresponding “stability period” of generally the same length even if their hours drop below full-time, provided they remain employed. The stability period can be no shorter than 6 months. The stability period can be no longer than the preceding measurement period.
Input the start date of the stability period and the number of months. ACA Compliance Solution will check for compliance.

**Step 4: Company Setup**

Provides basic setup information for a company. Select a company from the Company ID drop down or select to create new. You will then be presented with the existing company data or have the option to define it for a new company. Click save to save the record and delete to remove the company. Clicking clear will undo changes and cancel the operation, returning you to the page as if you first arrived.

**Company Information**

- Company ID
- Company Name
- EIN
- Phone Number
- Country
- Address1
- Address2
- City
- State
- Zip

**Electronic Filing Mask SSN:** This option is only used in instances when the user is filing forms electronically to the IRS. When checked, this option will cause the printed forms to mask the first 5 digits of the employee Social Security Number. It is used primarily when distributing copies of the forms to employees who have privacy concerns with the personal information. NOTE: if you are submitting printed forms to the IRS and not filing electronically, then this option should be unchecked when printing the copies you intend to send to the IRS. You can recheck the option for printing employee copies if you wish.
Step 5: Employee Data Import

The system requires the employees be imported using the Import utility. If you already have the Employee Excel file ready to import you can complete the Step 6: Import Employees. If you do not have the sample Excel file ready, we offer a SQL script to Microsoft Dynamics GP customer that will create a SQL view with the relevant information from Microsoft Dynamics GP. You can then create a connection to the SQL view in Excel. For additional details, see the Employee Master Upload section below.

Importing Employees

The import process for employees supports 4 optional columns to import file to accommodate the fields mentioned above. An example is provided below in excel format as an example. Remember that the actual import file must be a tab delimited text file. Excel import do not work. This image is provided only as a sample to show the fields and proper spelling of the column headers.

<table>
<thead>
<tr>
<th>EMAILADDRESS</th>
<th>ATTACHMENTPASSWORD</th>
<th>OPTINNW2</th>
<th>OPTIN1095C</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:cloudbusertest3@gmail.com">cloudbusertest3@gmail.com</a></td>
<td>Password121@</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td><a href="mailto:cloudbusertest4@gmail.com">cloudbusertest4@gmail.com</a></td>
<td>Password121@</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td><a href="mailto:integritywilbur@gmail.com">integritywilbur@gmail.com</a></td>
<td>Password121@</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td><a href="mailto:wilbur-id@hotmail.com">wilbur-id@hotmail.com</a></td>
<td>Password121@</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td><a href="mailto:cloudbusertest3@gmail.com">cloudbusertest3@gmail.com</a></td>
<td>Password121@</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td><a href="mailto:cloudbusertest4@gmail.com">cloudbusertest4@gmail.com</a></td>
<td>Password121@</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

The employee import process also supports an “email-only” feature. Also known as the mini import. In this mode the system will accept a file containing only two columns “EMPLOYEEID” and “EMAILADDRESS”. This is most often used to update existing employees in the system with an email address. Importing a list of employees that are already in the system will only update the employees and add the email address. It will not damage or alter any existing data for that employee as part of the mini
import. It will also not create new employees which don’t yet exist. IF any employees in the file are not already in the system then the process will abort and error will be logged. An example tab delimited file is shown below:

<table>
<thead>
<tr>
<th>EMPLOYEEID</th>
<th>EMAILADDRESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>HW0002</td>
<td><a href="mailto:cloudservices3@gmail.com">cloudservices3@gmail.com</a></td>
</tr>
<tr>
<td>SM0003</td>
<td><a href="mailto:cloudservices4@gmail.com">cloudservices4@gmail.com</a></td>
</tr>
<tr>
<td>FS0004</td>
<td><a href="mailto:integritywilbs@gmail.com">integritywilbs@gmail.com</a></td>
</tr>
<tr>
<td>HT0008</td>
<td><a href="mailto:wilbs@hotmail.com">wilbs@hotmail.com</a></td>
</tr>
<tr>
<td>TB00016</td>
<td><a href="mailto:cloudservices3@gmail.com">cloudservices3@gmail.com</a></td>
</tr>
<tr>
<td>PA00018</td>
<td><a href="mailto:cloudservices4@gmail.com">cloudservices4@gmail.com</a></td>
</tr>
<tr>
<td>ML00035</td>
<td><a href="mailto:dave@abwlink.com">dave@abwlink.com</a></td>
</tr>
<tr>
<td>SP00071</td>
<td><a href="mailto:dave@abwlink.com">dave@abwlink.com</a></td>
</tr>
<tr>
<td>TR00072</td>
<td><a href="mailto:cloudservices3@gmail.com">cloudservices3@gmail.com</a></td>
</tr>
<tr>
<td>AE00074</td>
<td><a href="mailto:cloudservices4@gmail.com">cloudservices4@gmail.com</a></td>
</tr>
<tr>
<td>FC00077</td>
<td><a href="mailto:integritywilbs@gmail.com">integritywilbs@gmail.com</a></td>
</tr>
<tr>
<td>LM00081</td>
<td><a href="mailto:dave@abwlink.com">dave@abwlink.com</a></td>
</tr>
<tr>
<td>LT00085</td>
<td><a href="mailto:wilbs@hotmail.com">wilbs@hotmail.com</a></td>
</tr>
<tr>
<td>BS00087</td>
<td><a href="mailto:cloudservices4@gmail.com">cloudservices4@gmail.com</a></td>
</tr>
<tr>
<td>RL00092</td>
<td><a href="mailto:cloudservices3@gmail.com">cloudservices3@gmail.com</a></td>
</tr>
</tbody>
</table>

When importing employee data (whether regular sized files or mini imports) the system allows the user to cancel the upload which is in progress. Since the cancel functionality essentially interrupts the update process of your import when it is trying to write to the database, there is a point in time after which the process cannot be stopped. Depending on the size of your upload file and the number of records, the cancel functionality may not have time to be invoked. During the window of time when a cancel is possible the “Upload Import” button changes to “Cancel”. You can attempt the cancelation during this time. After pressing the button, allow some time for the process to finish. When done the system will change the status of the upload to “Cancelled” appended with the Date and Time.

You may have attempted to cancel the import but after waiting, the status does NOT say “Canceled” and instead it appears the import simply proceeded to completion. This can happen when the background database function was already committing records and could not process your cancellation request even though the user interface appeared to accept it. This can happen on small sized uploads where the window of time is very short and the system processes the upload too quickly for the user to react in time.
Step 6: Import Employees
The system will import a tab delimited text file in the Upload and Import Data window. Within Excel save the file as a Tab Delimited file. Within the Email 1095-C solution select the Select file option to upload the employee data.
Step 7: View Payroll Employee

After the import, you can now review the employee data. An employee records contains many fields for demographic information but the four fields that are specific to the Email Employee functionality are:

- **E-Mail Address** - This field is contains the email address which will be used to correspond with the employee. Make sure to enter a valid address and confirm that this is the address the employee wishes to receive potentially sensitive information. Email address functionality is currently limited to 100 characters. If you elect to enter more than one email address for an employee then you should:
  - Separate the email with a semicolon (no extra spaces)
  - Ensure the aggregate character count doesn’t exceed 100 for all email lengths combined

- **Attachment Password** – This field contains can contain an alphanumeric password (special characters are allowed) up to 20 characters

- **Opt In W2** – This checkbox is used to indicate whether the employee has elected to receive their W-2 electronically. When checked this option will be available during the Email Employee Process. *(This function is currently reserved until a future release)*

- **Opt In 1095-C** – This checkbox is used to indicate whether the employee has elected to receive their 1095-C electronically. When checked this option will be available during the Email Employee Process.

The figure below shows an example of the Payroll Employee user interface with the relevant fields highlighted.
### Payroll Employee

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee ID</td>
<td>BC00022</td>
</tr>
<tr>
<td>First Name</td>
<td>Cameron</td>
</tr>
<tr>
<td>Middle Name</td>
<td>U</td>
</tr>
<tr>
<td>Last Name</td>
<td>Brickman</td>
</tr>
<tr>
<td>SSN</td>
<td>555-34-7778</td>
</tr>
<tr>
<td>Address 1</td>
<td>601 Windsor Court</td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>Lincoln</td>
</tr>
<tr>
<td>State</td>
<td>IL</td>
</tr>
<tr>
<td>Zip</td>
<td>62656</td>
</tr>
<tr>
<td>Birthdate</td>
<td>1/1/1980</td>
</tr>
<tr>
<td>Department</td>
<td>Main</td>
</tr>
<tr>
<td>Job Title</td>
<td>Manager</td>
</tr>
<tr>
<td>SUTA State</td>
<td>IL</td>
</tr>
<tr>
<td>Emp Type</td>
<td>Full Time</td>
</tr>
<tr>
<td>E-mail Address</td>
<td><a href="mailto:cameron@tramore.com">cameron@tramore.com</a></td>
</tr>
<tr>
<td>Attachment Password</td>
<td>••••••••</td>
</tr>
<tr>
<td>Opt In W2</td>
<td>☑️</td>
</tr>
<tr>
<td>Opt In 1095C</td>
<td>☐</td>
</tr>
<tr>
<td>Hire Date</td>
<td>8/1/2014</td>
</tr>
<tr>
<td>Adj Hire Date</td>
<td>8/1/2014</td>
</tr>
<tr>
<td>Terminated Date</td>
<td>8/1/2014</td>
</tr>
<tr>
<td>User Defined</td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>☑️</td>
</tr>
<tr>
<td>Date Inactivated</td>
<td>5/5/2015</td>
</tr>
</tbody>
</table>
Note the attachment password field’s use of the “eye” icon. This will reveal the password in clear text to the user when entering a password for the first time or after clearing a password and typing a new one. It is used to provide confirmation the password was entered correctly. This function is invoke by clicking and holding the mouse on the icon. See the figure below for an example.

![Figure](image.png)

For security reasons, once a password is entered and saved, this feature is not available.

**Note:** When importing data for an employee please ensure that the email address is valid. Also, passwords in the import file will be encrypted in the database during the import process and will not be visible in the Payroll Employee interface after import. They will instead be masked.
Microsoft Dynamics GP Client Side Features
With the latest Employee E-Mail Suite version, you will have a window to sync the information for 1095C to the Email 1095C Solution. Step 7 takes you through this process. You can download the latest version here.

Step 8: 1095-C Export
This utility allows the user to export employee 1095-C data in a format that can be consumed by the Cloud Services component responsible for emailing the 1095-C to employees. The utility accommodates 1095-C data originating from either:

- Microsoft GP ACA
- Integrity Data ACA

Which source the user selects will depend upon what ACA solution the user has employed in their environment. The main interface is depicted below followed by a more in depth discussion of the utility by feature.

Microsoft Dynamics GP > Tools > Routines Payroll > 1095-C Export

Configuration
ACA Solution - Select the option which most accurately reflects which ACA solution is being employed at your company. This setting allows the utility to pull the 1095-C data from the proper tables for export to the Cloud Services component. Note that this selection may be disabled and set to Microsoft GP ACA if you do not have the Integrity Data ACA solution installed.

Employer Self Insured – This setting allows the user to indicate whether the company is self-insured or not (important for certain fields on the 1095-C). The field is disabled when the solution is set to Integrity Data ACA, because that option is determined elsewhere in the system. See Integrity Data ACA Solution user documentation.
**Security Status** – This read only field alerts the user to the status of their connection to the cloud services component which is needed to ensure that the upload processes correctly. A status of “Connected” means the system is ready to attempt a process. A status of “not connected” means the system doesn’t have the information it needs to establish a connection to the destination for the export. The user will need to first make sure there is a connection before processing this upload. See the Update button below for further instructions.

**Employee ID Type** – This setting allows the user to indicate to the export process how the employees are identified in the cloud services component. (e.g., employees are listed by a unique employee ID or are listed by social security number) This allows the process to match an employee in the system with the same employee in the cloud services component, ensuring that the proper 1095-C information gets to the proper employee during the export.

- **Employee ID** – set to this value if employees in the cloud services component are identified by their Employee ID
- **Social Security Number with Dashes** - set to this value if employees in the cloud services component are identified by their individual Social Security Numbers separated by dashes.
- **Social Security Number without Dashes** - set to this value if employees in the cloud services component are identified by their individual social security numbers only (aka no dashes)

**Reporting Year** – This drop down list contains a list of years which correspond to the years which have been closed and are ready for export. For user of the Integrity Data ACA solution, this means the years for which you have run a year end close on the ACA product. For user of the Microsoft GP ACA solution, this means a list of years that have been closed in GP Payroll.

**Company ID** – This read only field displays the Company ID and name of the company about to be exported. There are no configurable options for this field.

**Processing Status** - This read only field alerts the user to the status of their upload once it has been exported to the cloud services component. The status is not dynamically refreshed so it is necessary to periodically check for new status after the upload is initiated (see the update button below for further instruction). A status of “Error” indicates there were errors with the import process once the data reach the cloud services component. Detail can be found in the error report (see Status Report below) A status of “Complete” means the process competed successfully. A status of “Pending” indicates the system is still processing the upload. You will need to check back again later.

**Button Functions**

**Update** (Security Status) – When pressed, the system will open a web browser and prompt the user to log into their tenant with their credentials. Once the log in is complete the user will be presented with a web page message indicating it is safe to close the browser. This is usually a one-time procedure and doesn’t need to be repeated. You may need to repeat this procedure if you have more than one company.

**Update** (Processing Status) – Pressing this button will retrieve the latest status for the export to the cloud services component. In addition to the status messages describe above, the system may also display a popup dialogue informing the user of any errors, which prevented the export. The error most often seen is “Successfully imported to blob” when the status is still “Pending” and the system is waiting its turn to continue. If you receive this message you can continue to wait for the system to upload the data.

**OK** – When pressed will simply close the utility window
**Process** – When pressed will begin the data gathering, configuring and export procedure. The button will be disabled until the procedure is either finished or errors out. At that point corrections can be made and another attempt made.

**Clear** – When pressed will reset the configuration setting on the utility window.

**Status Report** – This button will display a status report to the user which will contain any error encountered during the export/import process to the cloud services component. Only errors are displayed in this report. If the process was successful then the expected result is that this report will be blank, shown below. Had there been an error it would have been listed. An example of an error that could be encountered is “Employee ID not found” which would appear under the column heading Cloud Services Status. This simply means the export file contained an employee that was not in the cloud services component and thus had no place to put the 1095-C data.

![Screen Output - EES 1095C Status Report](image)

The upload process will overwrite any 1095-C data found for a given employee/company/year combination if it exists. Otherwise it will create a new record for the employee.
**Step 9: Templates**

This functionality allows the user to save a set of configuration information described above as a template, and assign it a name. When subsequent correspondence is sent via Email Employees the user will have the ability to either use an existing template or specify new criteria from scratch. The user is asked to make this choice when they visit the Email Employees page. See below.

The user is only prompted to create a template from existing settings when an email has been sent using the criteria. This happens during the Send process. See message below.
Step 10: Email Employees

This utility is where the user will designate and restrict recipients, compose the actual correspondence to be sent, and determine which attachments to include. The main interface is depicted below followed by a more in depth discussion of the utility by section.
General
This section allows the user to dictate the content of the email and other attributes of the correspondence.

**General**

**Subject** – Contains the text that will be displayed in the subject line of the email

**Body** – Contains the content of the email that will be sent to the employees. There is a 250 character limit to the body content.

**BCC** – Contains the email address of the recipient of the Blind Carbon Copy. This will not be visible to the employee and is typically a special email address set up to receive the correspondence as proof that the email was actually sent.

**Reply-To Address** – This email address will be visible to the employee. If the employee elects to respond to the email the address specified in this field will be the recipient of the reply. Typically, this is a dedicated email account for the payroll department or for support.

---

Subject: End of Year Forms

Body:

Greetings. Attached you will find your end of year statements for the documents you elected to receive. You may expect further communication when an item changes.

Your Payroll Team

BCC: confirmation@fabrikam.com

Reply-To Address: payroll_dept@fabrikam.com
1095-C and General Attachments

This section allows the user to select whether or not to attach a 1095-C or other general attachments to the email correspondence. More than one general attachment may be attached and more than one 1095-C may be specified.

**1095-C**

Attach 1095-C – When checked, the system will expand the 1095-C data area to accommodate further configuration.

**Year** – This DDL allows the user to specify which year to use when selecting 1095-Cs to attach. The year refers to the calendar year for the 1095-C.

**Company** – This configuration option is a multi-select list which will allow the user to select one or more companies to include in the 1095-C selection. In this way, more than one 1095-C may be sent to an employee. Note that this option will only send multiple 1095-Cs to an employee if that employee actually has 1095-C data for more than one company AND those companies are selected in the list. Employees who do not have 1095-C data for a given company won’t receive one for that company.

**Note:** For the company list box to contain a list of companies, those companies must first be set up in the configuration section of the system Configuration > ACA Setup > Company

**Password** – This drop down list contains 3 options for password protection and are thusly explained:

- None – The attachments will not be password protected
- Last 4 of Employee SSN – The attachments will require the recipient to enter the last 4 digits of the recipients SSN to be accessed
- First 5 of Employee SSN – The attachments will require the recipient to enter the first 5 digits of the recipients SSN to be accessed

---

**General Attachments**

Select files...

- CHANGE FORM.doc
- download.txt
NOTE: The password protection applies to the 1095-C attachment only. General attachments are not subject to password protection.

Important: If an employee has specified a custom password, then that password will be used during the process. Otherwise the settings specified in this password section shall prevail. Employee custom password always override the settings here.

Include 1095-C Instructions – Checking this box will cause the system to include an extra attachment to the email correspondence, namely the instruction file for 1095-C.

Download 1095-C Instructions – This is a hyperlink to instruction file that will allow the user to preview the contents before deciding whether or not to attach it. See Include 1095-C Instructions above.

Select Files – Pressing this button will present a dialogue window to the user allowing him to select a file. The selected file will be attached to the correspondence as a general, non-password protected, attachment during the send event. The user may attach files which have any of the following file types:

- .pdf
- .txt
- .rtf
- .doc
- .docx
- .jpg
- .jpeg
- .png
- .gif
- .tiff
- .tif
- .ico

Attachments are limited to 25MB in size (per attachment)

If a user changes any of the criteria specified in the 105-C Data section of the form, the system will prompt to refresh the recipients list. This is because the pool of recipients may have changed or the system needs to re-factor the process to account for new password criteria. The message prompt in this circumstance appears as seen in the figure below.

After pressing the “Refresh Recipients List” button the system message will disappear and the user may continue as before.
Recipients List

This section allows the user to define and constrain a subset of employees in the form of a recipient list. Restrictions are applied in the “Restrict Recipients By” section and then displayed in the grid below that. Finally, when the list is configured as desired and the attachments are selected, the user can select to send the email or cancel and clear the form.

Employee ID (Start / End) – This pair of fields allows the user to specify a range of employee ID’s to include in the recipient list. The range need not include an actual Employee ID (eg... the user may enter “aa” and “zz” and the system will include all employee IDs in between) The lookup button will open a dialogue allowing for a more refined search.

Department (Start / End) – This pair of fields allows the user to specify a range of departments to include which will constrain the employee result set. The department list is the sum of unique departments included in all the employee records so there is no single list which can be used in a lookup. The system will rely on alphabetical ranges to include departments.

Status (All / Active / Inactive) – This restriction refers to the employee status on the employee record and allows the user to include either active/inactive. The default setting is “all” which includes all employees regardless of status.
**Attachment Type** – There is only the 1095-C checkbox, which, when checked, will include only those employees in the recipient list who have 1095-C data. (i.e. will receive a 1095-C for at least one company)

**Apply Restrictions** – When pressed will apply the restrictions to the system and refresh the recipient list.

**Clear Restrictions** – When pressed will clear all restrictions and return the list to the state which includes all employees.

**Recipient List**

This grid displays a list of employees who will be candidates for inclusion in the sending of correspondence, based on the restriction put in place above. The columns display Employee ID, Name, Email Address, and 1095-C indicator. It is meant as a quick reference to quickly convey the size and content of employee list for those who will be a recipient of correspondence. The 1095-C indicator will display a green checkmark or a crossed out circle. These indicate the user will receive or not receive a 1095-C attachment respectively. The email address column will convey which employees if any are missing an email address or need corrections. Finally, the checkmarks on the left will allow the user to include or exclude which employees in the already refined list of recipients will receive the correspondence. The user adjust how many employees display in the list at a time using the control at the bottom of the window. The system also displays a count of the number of recipients which have been selected.

**Send E-Mail** – When pressed will send the email to the recipients selected. They system will prompt with a confirmation dialogue before actually processing the request.

It is important to note that this request may take a while to process. The system must create pdf versions of the 1095-Cs for each employee and if applicable password protect the file. Additionally the system must process other attachments that may or may not be present. The resultant pdf file for 1095-C will be named “1095C.pdf”. This will be true for all employees. The name of the general attachment will be the same as the attachment name at the time it was specified in the settings.

**Cancel & Clear Form** – When pressed will cancel any configuration changes and clear the entire form, returning it to the state when the page was first opened.
Hints, Essentials and FAQs

How long does it take to process the e-mails?
Below is a table of performance measurements from our quality assurance process:

<table>
<thead>
<tr>
<th># of Employees</th>
<th>Processing time in minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,500</td>
<td>24</td>
</tr>
<tr>
<td>4,000</td>
<td>63</td>
</tr>
</tbody>
</table>

This information was based on the following system requirements.

Test Configuration

<table>
<thead>
<tr>
<th>Computer Model:</th>
<th>Dell Optiplex 755</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU:</td>
<td>Core 2 Duo Q9550 2.83 Ghz</td>
</tr>
<tr>
<td>RAM:</td>
<td>Four GB RAM</td>
</tr>
<tr>
<td>Disk Controller:</td>
<td>IntellICH-9 SAT AHCI controller</td>
</tr>
<tr>
<td>Disks:</td>
<td>SATA 250 GB7200 RPM</td>
</tr>
</tbody>
</table>

General System Setup

- Server/Client
- OS Server 03
- Intel 82566 DM-2 GB Ethernet NIC

What are the system requirements Employee E-Mail Suite?
1. Microsoft Dynamics GP Payroll
2. Direct Deposit must be registered, setup and active
3. .NET Framework 3.5
4. Adobe Acrobat version 8, 9 or X installed on the machine processing E-Mail Earnings Statements
5. Microsoft Outlook 2003, 2007 or 2010, or SMTP Server

Will Employee E-Mail Suite work with a Terminal Server?
Yes, E-Mail Earnings Statements will work on a Terminal Server.

Can the e-mail earnings statements and W-2 statements be sent to multiple e-mail addresses?
Yes, e-mail earnings statements and W-2 statements can be sent to multiple e-mail address. See the Assign Multiple E-Mail Addresses to an Employee section of this user guide.

Is the PDF statements secure while it is stored on a drive?
Yes, once the e-mail process is complete the PDF file is secure.
Are any e-mails produced if a payment is voided?
No, an e-mail is not produced if a payment is voided. However, you do not have to send the e-mails until the payroll information has been corrected and verified. If an earnings statement is voided before the e-mails are sent the employee will be removed from the e-mail list.

Can the E-Mailed Earnings Statements be resent and will it still be secure?
Yes, navigate to the E-Mail Earnings Statements window select the appropriate payroll run and employee.

Will an employee need to have Adobe Reader to open the e-mailed statements?
Yes, the employee will need to have Adobe Reader installed on their personal computer in order to open the earnings statement or W-2 statement. In the e-mail body you can manage notifying the employee that they would need Adobe Reader. You can also include a link to a website where the employee can download Adobe Reader.

How do I prevent this error message? "When you create a PostScript file you must rely on system fonts and use document fonts. Please go to the printer properties, "Adobe PDF Settings" page and turn OFF the option "Rely on system fonts only; do not use document fonts".
Unmark the "Rely on system fonts only; do not use document fonts" option:

1. Click the Start button
2. Click Control Panel
3. Click Printers and faxes
4. Right click on the Adobe Printer
5. Select Printing Preferences
6. Unmark “Rely on system fonts only; do not use document fonts”
7. Select Apply
8. Close the Adobe PDF Printing Preferences window
Can I change the default zoom option within Adobe?
Yes, to change the default zoom option within Adobe:

1. Click Edit from the menu and then select Preferences
2. Within the Preferences window, choose the Page Display from the Categories section
3. Under the heading labeled “Default Layout and Zoom,” find Zoom. Choose the desired default zoom option from the menu (100%)
4. Click OK to close the Preferences window

Does the E-Mail W-2 Statements product print a copy for the employer to retain for their records?
Yes. E-Mail W-2 Statements product does print a copy for the employer to retain for their records.

Does the E-Mail W-2 Statements product print the W-3 Transmittal form that needs to be submitted to the government?
No. The W-3 Transmittal form still needs to be completed for the government within Microsoft Dynamics GP under the HR and Payroll pane select Routines > Payroll > Print W-2s.

Does the E-Mail W-2 Statements product complete the W-2 electronic filing?
No. The W-2 electronic filing still needs to be completed within Microsoft Dynamics GP under the HR and Payroll pane select Routines > Payroll > W-2 Electronic Filing.
Can the user reprint the W-2 statement after filing?
Yes. W-2 statements can be reprinted after filing. Within Microsoft Dynamics GP, open the E-Mail W-2 Statements window under the HR and Payroll pane select Routines > Payroll > E-Mail W-2 Statements, filter to the employee and click Process.

Can the E-Mailed W-2 Statements be resent and will it still be secure?
Yes, you can navigate to the drive/folder where the PDF files are stored and attach the secure PDF file to an e-mail and resend the secure earnings statement.
Activation Manager Messages

Activation Failed: Trial invalid or trial period expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Activation Failed: Site name does not match this installation
Situation: The site name does not match the token which was issued.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the account can be updated with the correct site name.

Activation Failed: Product Name does not match this installation
Situation: The product name does not match the token which was issued for a product.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the account can be updated with the product.

Trial period for Employee Email Suite has expired
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

Employees Allowed has been exceeded
Situation: The current employee count has exceeded the employees allowed.
Solution: Contact sales@integrity-data.com to upgrade to the next employee count tier level.

Activation Failed: Unable to contact web service. Activate manually or revert to previous product dictionary
Situation: The system could not make a connection to the web service.
Solution: Contact support@integrity-data.com for assistance.

Activation Failed: Product has been deactivated
Situation: The product has been deactivated.
Solution: Contact support@integrity-data.com for assistance.

Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to previous product version.
Situation: User attempted to upgrade a product when their enhancement plan was expired.
Solution: Contact sales@integrity-data.com to renew the enhancement plan.

Employee Email Suite: Activation Failed
Situation: Communication breakdown between the user machine and Integrity Data web services.
Solution: Contact support@integrity-data.com for assistance.
Deactivate Product

There are three ways to deactivate the Employee E-mail Suite; disable, inactive or uninstall.

Disable
To disable Employee E-mail Suite without having to exit Microsoft Dynamics GP, open the Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and then click Customization Status. Select the product from the list and click Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP.

Inactivate
Option 1: Employee Email Suite and E-Mail W-2 Statements can be inactivated by company, open the Activation Manager window and unmark the company checkbox.

Option 2: Employee Email Suite and E-Mail W-2 Statements can be inactivated by opening the E-Mail Earnings Statement Setup window and unmarking the Activate E-Mail Earnings Statement checkbox. To open this window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select Payroll and then select Employee Email Suite and/or E-Mail W-2 Statements.

Uninstall
If Employee E-mail Suite needs to be uninstalled complete these steps on the server and the client where Employee Email Suite has been installed.

1. Remove the EES.DIC file from the Runtime Directory
   Default location is C:\Program Files (x86)\Microsoft Dynamics\GP2018
2. Remove the Employee E-Mail Suite dll files
   Application.EmployeeEmailSuite.dll
   itextsharp.dll
   Integrity.Email.Addin.dll
3. Make a copy of the Dynamics.set file
4. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:
      5974
      Employee E-mail Suite
      :C:Program Files (x86)\Microsoft Dynamics\GP2018\EES.DIC
      :C:Program Files (x86)\Microsoft Dynamics\GP2018\Data\F5974.DIC
      :C:Program Files (x86)\Microsoft Dynamics\GP2018\Data\R5974.DIC

If you do not have any other Integrity Data product installed remove our activation files from the Runtime Directory. Default location is C:\Program Files (x86)\Microsoft Dynamics\GP2018

IDA6537.cnk
Application.IntegrityDataActivation.dll
Integrity.Registration.Constructor.dll
Integrity.Registration.Addin.dll
5. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:
      
      6537
      Integrity Data Activation
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/IDA6537.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537F.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537R.DIC

6. Edit the Dynamics.exe.config
   a. Navigate to the GP folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
   b. Backup the Dynamics.exe.config by making a copy and saving the copy. **Important**
   c. Open Dynamics.exe.config in Notepad
   d. Find the <addin> and under <Dynamics> remove the following:
      <addin name="IDEmailSuite"
      type="Integrity.Email.Addin.GPAddIn,Integrity.Email.Addin,Version=12.0.1.1,Culture=neutral,PublicKeyToken=ac5d14cfdc907c65"/>
      This removes our activation reference, if you have other products from Integrity Data
      installed do not remove this
      <addin name="IDKeyManagerAddIn"
      type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=11.0.5.20123,Culture=neutral,PublicKeyToken=b7ed3ef026e3bc"/>
      f. This removes our activation files, if you have other products from Integrity Data installed
         do not remove this
         Under <DynamicsGPweb> remove the following:
         <addin name="IDKeyManagerAddIn"
         type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=11.0.5.20123,Culture=neutral,PublicKeyToken=b7ed3ef026e3bc"/>
   e. Save the Dynamics.exe.config file in the Microsoft Dynamics GP folder
   h. Login to GP
7. Save the Dynamics.set file
8. Launch Microsoft Dynamics GP and login as the ‘system administrator’
**Uninstall Activation Manager**

Activation Manager will manage activation for all Integrity Data Products. If you are uninstalling all Integrity Data products, you need to remove the Activation components.

**IMPORTANT**: If you uninstall one product but have other Integrity Data products do not uninstall the Activation Manager components.

1. **Make a copy of the Dynamics.set file**
2. **Open the Dynamics.set file**
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:

   ```
   6537
   Integrity Data Activation
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/IDA6537.DIC
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537F.DIC
   :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537R.DIC
   ```

   1. **Save the Dynamics.set file**

Make a copy of the Dynamics.exe.config file.

3. **Edit Dynamics.exe.config and find the line(s) beginning with:**

   ```
   <addin name="IDKeyManagerAddin"
   ```

4. **Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections.**

5. **Save the Dynamics.exe.config file**

6. **Launch Microsoft Dynamics GP and login as the ‘system administrator’**
Contact Information

Get quick answers to your questions

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162.

If you have registered your product, Technical Customer Service is available for any customers with a current Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support should always be your VAR (if you have one).

Join our User Groups

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join!

Rate us and our products

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the form on our contact page and leave your quote in the comment section.

Suggest new features or improvements

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our Director of Client Services, at tfranz@integrity-data.com or David, our Product Manager at dwilmert@integrity-data.com. As always, technical ideas and user input are highly encouraged. At Integrity Data, we want to hear your input, so drop us a line!

Browse our solutions

The Integrity Data website is a great place to get additional information on products and services. The following information is available on our website:

- Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI Calculators
- Visit our Services page to learn more about our additional customization services

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail sales@integrity-data.com.